
Sr
i

SAI RAM INSTITUTE OF TECHNOLOGY
Accredited by NBA and NAAC “A+” |  An ISO 9001:2015 Certified and MHRD NIRF ranked institution

An Autonomous Institution  | Affiliated to Anna University & Approved by AICTE, New Delhi

Sai Leo Nagar, West Tambaram, Chennai.  www.sairamit.edu.in

The Institution of Engineers (India)
Hosted by

Kanchipuram Local Centre 

under the ageis of Computer Engineering Division, IEI

26.07.2023 & 27.07.2023

ALL INDIA WORKSHOP ON

MICROSOFT POWER BI DESKTOP
FOR DATA ANALYSIS AND DATA VISUALIZATION

ATAL RANKING OF INSTITUTIONS
ON INNOVATION ACHIEVEMENTS

ARIIA 

RANKING
INSTITUTIONS

(Ministry of Education Initiative)EXCELLENT BAND

ATAL RANKING OF INSTITUTIONS
ON INNOVATION ACHIEVEMENTS

ARIIA 

RANKING
INSTITUTIONS

(Ministry of Education Initiative)EXCELLENT BAND

DEPARTMENT OF INFORMATION TECHNOLOGY
In association with



The Institution of Engineers (India) or IEI is the largest multidisciplinary 

professional body that encompasses 15 engineering disciplines and gives 

engineers a global platform from which to share professional interest. IEI has 

membership strength of over 0.8 million. Established in 1920, with its 

headquarters at 8 Gokhale Road, Kolkata - 700020, IEI has served the 

engineering fraternity for over nine decades. In this period of time it has been 

inextricably linked with the history of modern-day engineering. In 1935, IEI was 

incorporated by Royal Charter and remains the only professional body in India 

to be accorded this honour. Today, its quest for professional excellence has 

given it a place of pride in almost every prestigious and relevant organization 

across the globe. IEI functions among professional engineers, academicians 

and research workers. It provides a vast array of technical, professional and 

supporting services to the Government, Industries, Academia and the 

Engineering fraternity, operating from 125 Centres located across the country. 

The Institution also provides grant-in-aid to its members to conduct research 

and development on engineering subjects.

IEI has been recognized as Scientific and Industrial Research Organization 

(SIRO) by the Ministry of Science & Technology, Government of India and 

besides conducting its own research, provides Grant-in-Aid to UG/PG/ PhD 

students of Engineering Institutes & Universities.

IEI holds the International Professional Engineers (IntPE) Register for India 

under the global International Professional Engineers Alliance (IntPEA). The 

Institution also awards the Professional Engineers (PE) Certification.
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I express my sincere appreciation to the participants and I am sure they will have fruitful 

discussion during the All India Workshop on “Microsoft Power Bi Desktop for Data Analysis and 

Data Visualization” held during 26.07.2023 to 27.07.2023 at Sri Sairam Institute of Technology, 

Tamil Nadu.

This is one another initiative by IEI Kanchepuram Local Centre to promote engineering activity 

among the students. I am told that there is an encouraging response from the students. My 

special appreciation to Dr.V.Brindha Devi,M.E.,Ph.D. Professor & Head of the Department, Sri 

Sairam Institute of Technology for organizing this event.

Dr. D. ELANGO, FIE

Council member & Chairman-IEI

KLC IEI- Kanchepuram Local Center
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It gives me immense pleasure in recording this message in the souvenir of the All India 

Workshop on “Microsoft Power Bi Desktop for Data Analysis and Data Visualization " to be held 

during 26.07.2023 to 27.07.2023 at Sri Sairam Institute of Technology, Chennai, Tamil Nadu 

which is organized by our Kanchepuram Local Centre jointly with Department of Computer 

Science and Engineering, Sri Sairam Institute of Technology. In fact, IEI-KLC is very vibrant in 

organizing such kind of technical events for the benefit of the budding and fellow Engineers.

I am very happy to note that an overwhelming response has been received from various branch 

students and faculty members to take part in this great event. I am confident that all the 

participants attending this workshop will get very good hands on experience and the contacts 

required to pursue in this topic in future.

Let me convey my best wishes and congratulations to the Organizing team, especially Prof & 

Head Dr.V.Brindha Devi,M.E.,Ph.D., Sri Sairam Institute of Technology for their great efforts in 

undertaking this laudable initiative.

I wish the Seminar a great success. 
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Introducing Power BI Desktop 

Microsoft’s Power BI is a business and data analytics service that enables professionals to process, 

analyze, and visualize vast volumes of data. It helps extract insights, draw conclusions, and share results 

in the form of reports and dashboards across various departments. It provides an easy drag and drops 

feature with a range of interactive data visualizations to generate reports and dashboards. 

Features of Power BI 

 Power BI is faster and performs better when there is a smaller volume of data 

 Power BI provides an interface based on Microsoft Office 365 that is user-friendly, intuitive, and 

easy to understand 

 Using Power BI, you can work with several data sources, such as Excel, Text/CSV, JSON, SQL 

Server databases, IBM DB2, MySQL, etc. 

 Power BI can connect with the R programming language, and it also supports various Data 

Analysis Expression (DAX) functions and measures 

 Power BI has functional integration with the Microsoft Azure cloud platform. It helps to analyze 

insights and patterns in datasets 

What is a Power BI Dashboard? 

Power BI dashboards are single-page documents, often referred to as canvas, which illustrate a story 

through visualizations. A well-designed dashboard consists only of the highlights of a story. This is due to 

the fact that it is limited to one page. For more information, readers can view related reports. Power BI is 

the only service that offers dashboards. 

Single page visualization with multiple charts and graphs to tell a story is called a Power BI dashboard. 

This one-page visualization in a dashboard is also known as a Canvas. The Power BI dashboard is a 

feature only available in Power BI Service. Since a Power BI dashboard is limited to one page, it only 

contains the highlights of a story. You cannot create a dashboard on Power BI Desktop. 

 

Fig: Power BI Dashboard on Power BI Service 

In a dashboard, visualizations are generated from reports, and each report is based on one dataset. The 

visualizations present on the dashboard are called tiles, and report designers pin these tiles to the 

dashboard. 
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Advantages of a Power BI dashboard 

 A Power BI dashboard enables users to analyze reports and view all important metrics at a glance 

 Using a Power BI dashboard, users can create visualizations from multiple datasets or multiple 

reports 

 You can customize dashboards to meet the requirements of any enterprise 

 Power BI dashboards can be embedded into applications to provide a unified user experience 

 You can instantly share a dashboard with other colleagues in your organization. 

 

Connecting & Shaping Data 

Shape data 

To shape data in Power Query Editor, you provide step-by-step instructions for Power Query Editor to 

adjust the data as it loads and presents the data. The original data source isn't affected; only this 

particular view of the data is adjusted, or shaped. 

The steps you specify (such as rename a table, transform a data type, or delete a column) are recorded by 

Power Query Editor. Each time this query connects to the data source, Power Query Editor carries out 

those steps so that the data is always shaped the way you specify.  

This process occurs whenever you use Power Query Editor, or for anyone who uses your shared query, 

such as on the Power BI service. Those steps are captured, sequentially, in the Query Settings pane, 

under APPLIED STEPS. We’ll go through each of those steps in this article. 

 

1. Import the data from a web source. Select the Get data dropdown, then choose Web. 

 

2. Paste this URL into the From Web dialog and select OK. 
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Copy 

https://www.fool.com/research/best-states-to-retire 

 

3. In the Navigator dialog, select Table 1, then choose Transform Data. 

 

4. The Power Query Editor window opens. You can see the default steps applied so far, in the Query 

Settings pane under APPLIED STEPS. 

 Source: Connecting to the website. 

 Extracted Table from Html: Selecting the table. 

 Promoted Headers: Changing the top row of data into column headers. 

 Changed Type: Changing the column types, which are imported as text, to their inferred types. 

 

5. Change the table name from the default Table 1 to Retirement Data, then press Enter. 

https://learn.microsoft.com/en-us/power-bi/connect-data/media/desktop-shape-and-combine-data/power-query-editor-query-settings-dialog.png#lightbox
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6. The existing data is ordered by a weighted score, as described on the source web page 

under Methodology. Let's add a custom column to calculate a different score. We'll then sort the table 

on this column to compare the custom score's ranking to the existing Rank. 

7. From the Add Column ribbon, select Custom Column. 

 

8. In the Custom Column dialog, in New column name, enter New score. For the Custom column 

formula, enter the following data: 

Copy 

( [Quality of life] + [Housing cost] + [Healthcare cost and quality] + [Crime rate rate] + [#"Public 

health/COVID-19 response"] + [Sales taxes] + [#"Non-housing costs"] + [Weather] ) / 8 

9. Make sure the status message is No syntax errors have been detected, and select OK. 

https://www.fool.com/research/best-states-to-retire/#:%7E:text=Methodology


6 
 

 

10. In Query Settings, the APPLIED STEPS list now shows the new Added Custom step we just 

defined. 

 

Adjust the data 

Before we work with this query, let's make a few changes to adjust its data: 

 Adjust the rankings by removing a column. 

For example, assume Weather isn't a factor in our results. Removing this column from the query 

doesn't affect the other data. 

 Fix any errors. 

Because we removed a column, we need to adjust our calculations in the New score column by 

changing its formula. 

 Sort the data. 

Sort the data based on the New score column, and compare to the existing Rank column. 

 Replace the data. 

We'll highlight how to replace a specific value and how to insert an applied step. 

These changes are described in the following steps. 

1. To remove the Weather column, select the column, choose the Home tab from the ribbon, and then 

choose Remove Columns. 
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2. Right-click a step to see its context menu. 

 

3. Move up the last step, Removed Columns, to just above the Added Custom step. 

 

4. Select the Added Custom step. 

Notice the New score column now shows Error rather than the calculated value. 

 

There are several ways to get more information about each error. If you select the cell without 

clicking on the word Error, Power Query Editor displays the error information. 
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If you select the word Error directly, Power Query Editor creates an Applied Step in the Query 

Settings pane and displays information about the error. Because we don't need to display error 

information anywhere else, select Cancel. 

5. To fix the errors, there are two changes needed, removing the Weather column name and changing 

the divisor from 8 to 7. You can make these changes in two ways: 

a. Right-click the Custom Column step and select Edit Settings. This brings up 

the Custom Column dialog you used to create the New score column. Edit the formula as 

described previously, until it looks like this: 

 

b. Select the New score column, then display the column's data formula by enabling 

the Formula Bar checkbox from the View tab. 

 

Edit the formula as described previously, until it looks like this, then press Enter. 

Copy 

= Table.AddColumn(#"Removed Columns", "New score", each ( [Quality of life] + [Housing cost] 

+ [Healthcare cost and quality] + [Crime rate rate] + [#"Public health/COVID-19 response"] + 

[Sales taxes] + [#"Non-housing costs"] ) / 7)               

6. Power Query Editor replaces the data with the revised values and the Added Custom step completes 

with no errors. 

7.  Note 
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8. You can also select Remove Errors, by using the ribbon or the right-click menu, which removes any 

rows that have errors. However, in this tutorial we want to preserve all the data in the table. 

9. Sort the data based on the New score column. First, select the last applied step, Added Custom to 

display the most recent data. Then, select the drop-down located next to the New score column 

header and choose Sort Descending. 

 

The data is now sorted according to New score. You can select an applied step anywhere in the list, 

and continue shaping the data at that point in the sequence. Power Query Editor automatically inserts 

a new step directly after the currently selected applied step. 

10. In APPLIED STEPS, select the step preceding the custom column, which is the Removed 

Columns step. Here we'll replace the value of the Housing cost ranking in Oregon. Right-click the 

appropriate cell that contains Oregon's Housing cost value, and then select Replace Values. Note 

which Applied Step is currently selected. 

 

11. Select Insert. 

Because we're inserting a step, Power Query Editor reminds us that subsequent steps could cause the 

query to break. 
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12. Change the data value to 100.0. 

Power Query Editor replaces the data for Oregon. When you create a new applied step, Power Query 

Editor names it based on the action, in this case, Replaced Value. If you have more than one step 

with the same name in your query, Power Query Editor appends an increasing number to each 

subsequent applied step's name. 

13. Select the last Applied Step, Sorted Rows. 

Notice the data has changed regarding Oregon's new ranking. This change occurs because we 

inserted the Replaced Value step in the correct location, before the Added Custom step. 

We’ve now shaped our data to the extent we need to. Next let’s connect to another data source, and 

combine data. 

Combine data 

The data about various states is interesting, and will be useful for building further analysis efforts and 

queries. However, most data about states uses a two-letter abbreviation for state codes, not the full name 

of the state. We need a way to associate state names with their abbreviations. 

There's another public data source that does provides that association, but it needs a fair amount of 

shaping before we can connect it to our retirement table. To shape the data, follow these steps: 

1. From the Home ribbon in Power Query Editor, select New Source > Web. 

2. Enter the address of the website for state 

abbreviations, https://en.wikipedia.org/wiki/List_of_U.S._state_abbreviations, and then 

select Connect. 

The Navigator displays the content of the website. 

 

3. Select Codes and abbreviations for U.S. states, federal district, territories, and other regions. 

 Tip 

https://en.wikipedia.org/wiki/List_of_U.S._state_abbreviations
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It will take a bit of shaping to pare this table’s data down to what we want. Is there a faster or easier 

way to accomplish the following steps? Yes, we could create a relationship between the two tables, 

and shape the data based on that relationship. The following example steps are helpful to learn for 

working with tables. However, relationships can help you quickly use data from multiple tables. 

To get the data into shape, follow these steps: 

1. Remove the top row. Because it's a result of the way that the web page’s table was created, we don’t 

need it. From the Home ribbon, select Remove Rows > Remove Top Rows. 

 

The Remove Top Rows dialog appears. Specify 1 row to remove. 

2. Promote the new top row to headers with Use First Row As Headers from the Home tab, or from 

the Transform tab in the ribbon. 

3. Because the Retirement Data table doesn't have information for Washington DC or territories, we 

need to filter them from our list. Select the Name and status of region_1 column's drop-down, then 

clear all checkboxes except State. 

 

4. Remove all unneeded columns. Because we need only the mapping of each state to its official two-

letter abbreviation (Name and status of region and ANSI columns), we can remove the other 

columns. First select the Name and status of region column, then hold down the CTRL key and 

select the ANSI column. From the Home tab on the ribbon, select Remove Columns > Remove 

Other Columns. 
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 Rename the columns and the table. There are a few ways to rename a column: First select the 

column, then either select Rename from the Transform tab on the ribbon, or right-click and 

select Rename. The following image shows both options, but you only need to choose one. 

 

5. Rename the columns to State Name and State Code. To rename the table, enter the Name State 

Codes in the Query Settings pane. 

 

Combine queries 

Now that we’ve shaped the State Codes table the way we want, let’s combine these two tables, or queries, 

into one. Because the tables we now have are a result of the queries we applied to the data, they’re often 

referred to as queries. 

https://learn.microsoft.com/en-us/power-bi/connect-data/media/desktop-shape-and-combine-data/state-table-remove-other-columns.png#lightbox
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There are two primary ways of combining queries: merging and appending. 

 For one or more columns that you’d like to add to another query, you merge the queries. 

 For one or more rows of data that you’d like to add to an existing query, you append the query. 

In this case, we want to merge the queries: 

1. From the left pane of Power Query Editor, select the query into which you want the other query to 

merge. In this case, it's Retirement Data. 

2. Select Merge Queries > Merge Queries from the Home tab on the ribbon. 

 

You might be prompted to set the privacy levels, to ensure the data is combined without including or 

transferring data you don't want transferred. 

The Merge window appears. It prompts you to select which table you'd like merged into the selected 

table, and the matching columns to use for the merge. 

3. Select State from the Retirement Data table, then select the State Codes query. 

When you select a matching columns, the OK button is enabled. 

 

4. Select OK. 

Power Query Editor creates a new column at the end of the query, which contains the contents of the 

table (query) that was merged with the existing query. All columns from the merged query are 

condensed into the column, but you can Expand the table and include whichever columns you want. 

5. To expand the merged table, and select which columns to include, select the expand icon (  ). 

The Expand window appears. 



14 
 

 

6. In this case, we want only the State Code column. Select that column, clear Use original column 

name as prefix, and then select OK. 

If we had left the checkbox selected for Use original column name as prefix, the merged column 

would be named State Codes.State Code. 

 To apply your changes and close Power Query Editor, select Close & Apply from the Home ribbon 

tab. 

The transformed dataset appears in Power BI Desktop, ready to be used for creating reports. 
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Creating a Data Model 

Data Modeling is one of the features used to connect multiple data sources in BI tool using a relationship. 

A relationship defines how data sources are connected with each other and you can create interesting data 

visualizations on multiple data sources. 

With the modeling feature, you can build custom calculations on the existing tables and these columns 

can be directly presented into Power BI visualizations. This allows businesses to define new metrics and 

to perform custom calculations for those metrics. 

 

In the above image, you can see a common data model, which shows a relationship between two tables. 

Both tables are joined using a column name “Id”. 

Similarly, in Power BI, you set the relationship between two objects. To set the relationship, you have to 

drag a line between the common columns. You can also view the “Relationship” in a data model in Power 

BI. 

To create data model in Power BI, you need to add all data sources in Power BI new report option. To add 

a data source, go to the Get data option. Then, select the data source you want to connect and click the 

Connect button. 

 

Once you add a data source, it is presented on the right side bar. In the following image, we have used 2 

xls file to import data - Customer and Product. 



16 
 

 

In Power BI on the left side of the screen, you have the following three tabs − 

 Report 

 Data 

 Relationships 

 

 

When you navigate to the Report tab, you can see a dashboard and a chart selected for data visualization. 

You can select different chart types as per your need. In our example, we have selected a Table type from 

available Visualizations. 
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When you go to the Data tab, you can see all the data as per the defined Relationship from the data 

sources. 

 

In the Relationship tab, you can see the relationship between data sources. When you add multiple data 

sources to Power BI visualization, the tool automatically tries to detect the relationship between the 

columns. When you navigate to the Relationship tab, you can view the relationship. You can also create a 

Relationship between the columns using Create Relationships option. 

 

You can also add and remove relationships in data visualization. To remove a relationship, you have to 

right-click and select the “Delete” option. To create a new “Relationship”, you just need to drag and drop 

the fields that you want to link between the data sources. 



18 
 

 

You can also use the Relationship view to hide a particular column in the report. To hide a column, right-

click on the column name and select the “Hide in report view” option. 

 
 

 

Creating Calculated Columns 

You can create calculated columns in Power BI by combining two or more elements of the existing data. 

You can also apply calculation on an existing column to define a new metric or combine two columns to 

create one new column.You can even create a calculated column to establish a relationship between the 

tables and it can also be used to setup a relationship between two tables. 

To create a new calculated column, navigate to Data View tab on the left side of the screen and then click 

Modeling. 
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When you navigate to the Modeling tab, you can see a New Column option at the top of the screen. This 

also opens the formula bar, where you can enter DAX formula to perform calculation. DAX- Data 

Analysis Expression is a powerful language also used in Excel to perform calculations. You can also 

rename the column by changing the Column text in the formula bar. 

 

In the following example, let us create a new column: Product Code (Product_C), which is derived from 

the last three characters of Prod_Id column. Then, write the following formula  

Product_C = RIGHT( Sheet1[Prod_Id],3) 
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A long list of formulas is also provided that you can use for creating calculated columns. You have to 

enter the first character of formula to be used in calculations as shown in the following screenshot. 

 
Creating Calculated Tables 

You can also create a new calculated table in data modeling in Power BI. To create a new table, navigate 

to the Data View tab on the left side of the screen, and then go to the Modeling option at the top of the 

screen. 

 

DAX expression is used to create the new table. You have to enter the name of a new table on the left side 

of the equal sign and DAX formula to perform the calculation to form that table on the right. When the 

calculation is complete, the new table appears in the Fields pane in your model. 

In the following example, let us define a new table - Table_CustC that returns a one column table 

containing unique values in a column in another table. 
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A new table is added under the “Fields” section in Power BI screen as shown in the following screenshot. 

Once the calculated column and calculated tables are created as per your requirement, you can use the 

fields in the Report tab in Power BI.To add these objects, you have to select a checkbox and a relationship 

is automatically detected if possible. If not, then you can drag the columns that you want to connect. 

 

To view the report, you navigate to the Report tab and you can see both “Calculated columns” and fields 

from the new “Calculated table” in the report view. 

 
 

Managing Time-Based Data 

Power BI allows to drill through time-based data by default. When you add a date field in your analysis 

and enable drill on your data visualization, it takes you to the next level of time-based data. 

Let us consider we have added Time-based table in Power BI visualization. We have added Revenue and 

Year column in our report. 
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Visualizing Data with Reports 

Visualizations are used to effectively present your data and are the basic building blocks of any Business 

Intelligence tool. Power BI contains various default data visualization components that include simple bar 

charts to pie charts to maps, and also complex models such as waterfalls, funnels, gauges, and many other 

components. 

 

In Power BI, you can create visualization in two ways. First is by adding from the right side pane to 

Report Canvas. By default, it is the table type visualization, which is selected in Power BI. Another way 

is to drag the fields from right side bar to the axis and value axis under Visualization. You can add 

multiple fields to each axis as per the requirement. 
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In Power BI, it is also possible to move your visualization on the reporting canvas by clicking and then 

dragging it. You can also switch between different type of charts and visualizations from the 

Visualization pane. Power BI attempts to convert your selected fields to the new visual type as closely as 

possible. 

Creating Map Visualizations 

In Power BI, we have two types of map visualization - bubble maps and shape maps. If you want to create 

a bubble map, select the map option from the visualization pane. 

 

To use a bubble map, drag the map from Visualizations to the Report Canvas. To display values, you 

have to add any location object to the axis. 

 

In the value fields, you can see that it accepts values axis such as City and State and or you can also add 

longitude and latitude values. To change the bubble size, you need to add a field to the value axis.You can 

also use a filled map in data visualization, just by dragging the filled map to the Report Canvas. 
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Note − If you see a warning symbol on top of your map visualization, it means that you need to add more 

locations to your map chart. 

Using Combination Charts 

In data visualization, it is also required to plot multiple measures in a single chart. Power BI supports 

various combination chart types to plot measure values. Let us say you want to plot revenue and 

unit_solds in one chart. Combination charts are the most suitable option for these kind of requirement. 

One of the most common Combination chart in Power BI is Line and Stacked column charts. Let us say 

we have a revenue field and we have added a new data source that contains customer-wise unit quantity 

and we want to plot this in our visualization. 

 

Once you add a data source, it will be added to the list of fields on the right side. You can add units to the 

column axis as shown in the following screenshot. 

 

You have other type of combine chart that you can use in Power BI - Line and Clustered Column. 
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Using Tables 

In Power BI, when you add a dataset to your visualization, it adds a table chart to the Report canvas. You 

can drag the fields that you want to add to the report. You can also select the checkbox in front of each 

field to add those to the Report area. 

With the numerical values in a table, you can see a sum of values at the bottom. 

 

You can also perform a sort in the table using an arrow key at the top of the column. To perform 

ascending/descending sort, just click the arrow mark, and the values in the column will be sorted. 

 

The order of the columns in a table is determined by the order in the value bucket on the right side. If you 

want to change the order, you can delete any column and add the other one. 

 



26 
 

You can also undo summarize or apply different aggregate function on numerical values in the table. To 

change the aggregation type, click the arrow in the value bucket in front of the measure and you will see a 

list of formulas that can be used. 

 

Another table type in Power BI is the matrix table that provides a lot of features such as auto sizing, 

column tables, and setting colors, etc. 

 
 

Modify Colors in Charts 

In Power BI, you can also modify the colors in the chart. When you select any visualization, it has an 

option to change the color. Following options are available under the Format tab − 

 Legend 

 Data Colors 

 Detail Label 

 Title 

 Background 

 Lock Aspect 

 Border 

 General 

To open these options, go to the Format tab as shown in the following screenshot. Once you click, you 

can see all the options available. 

 

When you expand the Legend field, you have an option where you want to display the legend. You can 

select − 
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 Position 

 Title 

 Legend Name 

 Color 

 Text Size 

 Font Family 

 

Similarly, you have data colors. In case, you want to change the color of any data field, you can use this 

option. It shows all objects and their corresponding colors in the chart. 

 

You also have Analytics feature in the tool, where you can draw lines as per requirement in data 

visualization. You have the following line types in data visualization − 

 Constant Line 

 Min Line 

 Max Line 

 Average Line 

 Median Line 

 Percentile Line 

 

You can opt for a dashed, dotted, or a solid line. You can select Transparency level, color, and position of 

the line. You can also switch on/off data label for this line. 
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Adding Shapes, Images and Text box 

Sometimes it is required that you need to add static text, images, or shapes to your visualization. In case 

you want to add header/footer or any static signatures, messages to data visualization this option can be 

used. 

You can also add URLs in the text box and Power BI uses those link to make it live. 

To add shapes, images and text box, navigate to the Home tab and at the top you will find an option to 

add images. 

 

You can insert different shapes in data visualization. To see the available shapes, click the arrow next to 

the Shapes button. 

 

When you click on the text box, it adds a text box in your Report canvas. You can enter any text in the 

text box and use the rich text editor to make formatting changes. 

 

Similarly, images can be added to data visualization to add logos or other images to data visualization. 

When you click the Image option, it asks for a path to pass the image file. 

You can add shapes by selecting any shape from the dropdown list. You can also resize it using different 

options. 
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Styling Reports 

In Power BI, you have flexible options to adjust the page layout and formatting such as orientation and 

page size of your report. Navigate to Page View menu from the Home tab and the following options are 

provided. 

 Fit to Page 

 Fit to Width 

 Actual Size 

 

By default, the page size in a report is 16:9; however, it is also possible to change the page size of the 

report. To change the page size, navigate to the Visualization pane and select Paint brush. 

Note − To change page size, no visualization should be added to the Report canvas. You have the 

following options available under Page layout − 

 Page Information 

 Page Size 

 Page Background 

Under Page Information, you have Name and Q&A. 

Under Page Size, you can select from the following options − 

 Type 

 Width 

 Height 

 

Under Page Background, you can select from the following options: 

 Color 

 Transparency 

 Add Image 
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Duplicating Reports 

In some scenarios, you may want to use the same layout and visuals for different pages. Power BI 

provides an option to create a copy of the page. When you use Duplicate Page option, a new page is 

added with similar layout and visuals.To duplicate a page, right-click the Page and select Duplicate Page 

option. This will create a copy of the same page with the name - Duplicate of Page1. 

 

Now, if you want to rename an existing page or delete a page, you can use other options as shown in the 

above screenshot. 

Artificial Intelligence Visuals 

Artificial intelligence is transforming businesses across the world. There are several tools and 

technologies to realize the benefits of AI efficiently and effectively. However, one software package that 

most organizations already have is Microsoft Power BI. Artificial Intelligence in Power BI comes with 

both functional and visual capabilities. 

Power BI is part of the Microsoft Power Platform. It has several software services, connectors, and apps. 

Together, they collaborate to provide interactive visualization and dash boarding capabilities. Power BI 

allows users to ingest data from almost any source, transform that data, and finally, visualize and slice & 

dice as needed. The final Power BI reports can be shared online or via Power BI Mobile apps. One of the 

more advanced features of Power BI is its unique AI capabilities. 

Artificial Intelligence Features in Power BI 

 

 

https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_637d2ea46c55e.png
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Reports & Visuals - The AI Visuals provide Key Influencers and a Decomposition Tree analysis. The 

Key Influencer capability of Power BI helps in understanding the factors that are affecting a specific 

metric. The Decomposition Tree analysis capability lets you slice and dice the data into different 

dimensions so that data can be viewed across multiple dimensions. 

Q&A (Question and Answers) and Quick Insights - They are the state-of-the-art capabilities of Power 

BI. They are one of the competitive advantages over other competing vendors. Power BI's Questions & 

Answers and quick insight capability lets you explore natural language processing by performing semi-

structured data exploration. It enables asking questions in natural language and provides answers in 

natural language. 

Dataflows and Power Query - These capabilities are used as a tunnel during data preparation that 

extracts, transforms, and loads data into Power BI. Power Query comes with a GUI (Power Query Editor 

user interface) used to transform and prepare data for further data modeling. Two Power Queries are 

available in Power BI - Power Query Online and Power Query for Desktop. The Power BI Query online 

is used for integrations within the Power platform and Power BI Dataflows. The Power Query for 

Desktop is used for integration within Power BI Desktop. 

Cognitive Services and Auto ML - Cognitive services can be used for Sentiment analysis, Image 

Tagging, and Key Phrase Extraction using unstructured data. Auto ML refers to Automated Machine 

Learning. This capability allows users to enable machine learning models by creating, training, and 

invoking ML models. Power BI lets you perform all the Machine learning activities right within itself. It 

is like a Low-Code-No-Code platform that allows a Citizens developer to build a machine learning model. 

Please note that you need Power BI Premium for this capability. 

Access AI-enabled report from PowerBI.com 

Microsoft has provided a sample for Artificial Intelligence in Power BI with a prebuilt AI report. We will 

use this report to learn the AI features in Power BI. 

As a first step, you need to go to https://app.powerbi.com/ and then sign in with your credentials. On this 

page, you can create a free Microsoft account and sign on to that page if you are not already registered. 

Once successfully logged in, you must click on “learn” in the navigation pane. This is the lower left 

highlighted icon in the image below.   

In the Sample reports, select “Artificial Intelligence Sample.” 

 

Power BI will automatically open the Artificial Intelligence report. You will see the report as shown 

below with three pages. 

Key Influencers 

Decomposition Tree and 

Anomaly Detection 

https://app.powerbi.com/
https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_63707705ac750.png
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These are shown in the pages blade in the workspace. 

 

Finally, your complete report should look like the one displayed below: 

 

Artificial Intelligence Exploration to Find the Top Contributors for Wins and Losses 

We will stay on the “Key Influencers” page to find the leading contributors for wins and losses. This is 

the default page that the report opens with. Key Influencers is the first AI visualization in Power BI. This 

was first made public in 2019 and has undergone several improvements. This feature helps us analyze the 

driver behind a condition or a trend. 

This report contains details about Product category, Revenue won by Product, and Key Influencers. The 

Power BI AI feature generated insights by looking at all the data to determine the factors with the highest 

impact. By default, you will notice the drop down after "What influences status to be" is Won. This 

indicates what the factors for the status to be Won are. The top two factors are as follows:When the 

Discount goes up by 0.02 (i.e., 2%), the likelihood of status being won increases by 2.76 timesWhen the 

Sales owner is Molly Clark, the likelihood of Status being Won increases by 1.52 times 

 

From the report’s stacked bar chart on its left, select the Software under Close % by Product 

Category. Power BI will generate new insights based on this selection. As a result, for Software, when 

the Sales Owner is Molly Clark, the likelihood of Status being Won increases by 1.60 times. 

https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_6370744696f81.png
https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_63707459e1b5f.png
https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_63707473c7dbe.png
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You can slice & dice this visual to answer similar questions for other product categories.Artificial 

Intelligence Exploratory Analysis to Find the Root Cause using a Decomposition TreeThe Decomposition 

Tree is one of the most highly interactive visuals within Power BI. It can be used for Exploratory Data 

Analysis to understand the root cause. The default decomposition tree report looks like the figure below. 

 

You can drill down the tree on this page by clicking on one of the categories. After that, we will select the 

corresponding Product to perform an AI Split. Lastly, we will identify the corresponding high and low 

values for Sales opportunities.On this visual, firstly, close the Product and Region. Now we should only 

have Categories listed on this page. Here, click on the + sign next to Furniture Category. 

 

This will pop up another menu with "High Value," "Low Value," etc. 

 

If you click on the "High Value," Power BI uses AI Splits to determine the highest value for the Furniture 

category. It will populate the High values for the Region for the Furniture Category. In the example, the 

highest value for the region is for “North America.” 

https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_6370747fd8fb8.png
https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_6370748f2a706.png
https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_637d477e63a74.png
https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_637074a136bba.png
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Here again, let’s click on the + sign next to North America.  

 

The similar menu will be displaced with "High Value," "Low Value," etc. Click on High Value, and the 

Power BI again runs the AI Split and determines the highest value of the Product for this Region. In this 

scenario, the highest value for the Product is “Stand-up Desks.” Clicking the + sign and selecting the 

High value again runs the AI Splits and determines the highest value for the Territory. We can keep going 

like this to determine the highest value for the Sales Owner. In this example, the highest value for the 

Sales owner is David So. 

 

 

 

 

 

 

https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_637074b552535.png
https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_637d4850607f2.png
https://www.sqlservercentral.com/wp-content/uploads/2022/11/img_63707646447e6.png
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